Android App’s Anatomy

Android Applications (Just Apps)

Android applications are usually created using the Java programming
language 1]

Apps must import various Android Libraries (such as android.jar, maps.jar,
etc ) to gain the functionality needed to work inside the Android OS.

Android apps are made of multiple elements such as: user-defined
classes, android jars, third-party libraries, XML files defining the Uls or
views, multimedia resources, data assets such as disk files, external arrays
and strings, databases, and finally a Manifest summarizing the ‘anatomy’
and permissions requested by the app.

The various app components are given to the compiler to obtain a single
signed and deployable Android Package (an .apk file).

Like “.class” files in Java, “.apk” files are the byte-code version of the app
that finally will be ‘executed’ by interpretation inside either a Dalvik
Virtual Machine (DVM) or an Android-Runtime Engine (ART).

[1] Visit http://xamarin.com/monoforandroid for a commercial i0OS and Android IDE that works with C# and Windows .NET




Android’s Byte-Code Execution

Dalvik Virtual Machine vs. Android Runtime (ART)

The Dalvik Virtual Machine is a Just-in-Time (JIT) runtime environment
(similar to the Oracle’s Java Virtual Machine JVM) that interprets Android
byte-code only when it’s needed (however it will be phased out soon).

The newer ART (introduced as an option in Android 4.4 KitKat ) is an
anticipatory or Ahead-of-Time (AOT) environment that compiles code before
it is actually needed.

ART promises:

 enhanced performance and battery efficiency,
 improved garbage collection,

 better debugging facilities,

* Improved diagnostic detail in exceptions and crash reports.

Quoting from

https://source.android.com/devices/tech/dalvik/art.htm| (Aug-27-2014)
Important: Dalvik must remain the default runtime or you risk breaking your Android
implementations and third-party applications.




Setting up Eclipse + ADT + SDK

You are a developer - Which is your SDK audience?

SDKs are named after types of .
. ; Android Current market
desserts. Available versions at i
. . SDK version share
the time of writing are:
4.4 (KitKat 42.0 %
1.5 Cupcake, (K ) °
1.6 Donut, 4.1-4.3 (Jelly Bean) 344 %
2.1 Eclair, ,
- o)
2.2 Froyo, 5.0-5.1 (Lollipop) 16.5 %
2.3 Gingerbread, 2.3 (Gingerbread) 3.5%
3.x Honeycomb, ]
4.0 Ice Cream Sandwich 4.0.x (ICS) 3.3%
4.3 Jelly Bean 2.2 (Froyo) 0.2%
4.4 Kitkat
5.x Lollipop 3.0-3.2 (Honeycomb) 0.1%
6.X Marshmallow 2.0-2.1 (Eclair) 0.0%

Statistics accessed on Sept 3, 2015 from AppBrain at http://www.appbrain.com/stats/top-android-sdk-versions




Tools for Constructing Android Apps

Development Workbenches

Android apps are made out of many components. The use of an IDE
is strongly suggested to assist the developer in creating an Android
solution. There are various options including:

 Eclipse+ADT. The classic general purpose Eclipse IDE can be
enhanced (with the ADT plugin) to provide a ‘conventional’ way
to create and debug Android Apps. The associated SDK Manager
allows you to reach the various API libraries needed by the apps.

e Android Studio is a new Android-only development
environment based on IntelliJ IDEA. It is the ‘preferred’ IDE
platform for Android development.

Android Studio

* Netbeans+Android. Similar to Eclipse+ADT. Soon to be
deprecated(?)



Eclipse + ADT + SDK

Typical Layout of the Eclipse-ADT IDE for Android Development

These icons

are added to
" i@ Java - 01-Hello-World/src/csu/matos/HelloActivity java - Eclipse Eclipse by. the
L ADT plugin
File Edit Source Refactor MNavigate 5earch Project Rug [
M~ 6% I - 60
EH G- @SSO P Sk
[% Package Explor i3 = Properties = O [J] HelloActivity.java 52
l] Opens Android SDK manager
- Opens Android AVD Virtual Device 5 [&7 Java @ DOMS #} Debug
Manager
ig:-;. Wizard creates a new Android Project Opens DDMS Perspective

—

Dalvik Debugging Monitoring System

Note: The DDMS and Hierarchy View can be manually added by the user to Eclipse’s tool bar



Android Studio

ANDROID

Typical Layout of Android-Studio IDE '@' studi

| §& CurrencyExchange - [C:\Users\1002125\AndroidStudioProjects\CurrencyExchange] - [app] - ~\app! =] 3|

File Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
BEO ¢«» X060 QR ¢ > H(Eao P e b @ SLE® ? Q
|”3 CurrencyExchange : " app ' []src » [CImain » []java » [ matos » [5] csu » |5 currencyexchange © € MainActivity

g:' 1&1 Android '1@ E - 3 ﬂ*—v € MainActivity.java X

o m
g|v Caaee import android.view.inputmethod.EditorInfo; ¥ §
o E,";j:‘f“‘s import android.widget.Button I Err I

import android.widget.EditTe

[5] matos.csu.currencyexch

& [ matos. csu.currencyexch import java.text.DecimalForm
= [Gres
“ [57] drawable
1 2 layout @ public class MainActivity ex Recent Projects
£ & activity_main.xml //USA money format (12 d
E 1 menu DecimalFormat usaDf = ne| Ml
r~1 T_) menu_main.xml
P .
v gm;na: // naive currency conver

vaiu . .

] dimens.xm (2 pr‘:f.vate f:f.nal double EUR

& strings.xml private final char EUROS

(5] styles.xml (2 private final double cCOL

& Gradle Scripts private final char COLON

w | Android
b No Connected Devices n No Debuggable Applications n

(ol I | =
| B0 | srilogcat | ADBlogs -*| il Memory -*| jl CPU -*|Verbose n l‘\(:.l' )

ﬁ' 09-03 12:03:00.030 1392-1392/system _process I/ActivityManage
%; é:], — 09-03 12:03:00.040 1392-1392/system_process I/ActivityManage

X
v |

Android Studio 0.8.6 Build 135.1339820. Check for updates now.

| Welcome to Android Studio

E? New Project...
E'g Import Project...
EE Open Project
V£S Check out from Version Control

,48 Configure

[F. Docs and How-Tos




Setting up Android Studio

Downloading Android Studio IDE

Download IDE from: https://developer.android.com/sdk/index.htm]|
Run the executable, you are (a/most) done!

€ ‘B Bl https://developer.android.com/sdk/index.html w9 N\NO =

Il Developers Design Develop Distribute B Console Q

Training APl Guides Reference Tools Google Services Samples Preview

Download

The official Android

Installing the SDK

Adding SDK
Packages
Android Studio IDE
Android Studio Android SDK tools
Android 6.0 (Marshmallow) Platfo
Workflow
Android 6.0 emulator system image
with Google APls
Tools Help
Build System
Peformance

Tools e Other Download Options




Setting up Eclipse + ADT + SDK

ECLIPSE SETUP
Prepare your computer — Install SDK: Windows, Mac, Linux

We assume you have already installed the most recent Java JDK and Eclipse
IDE in your computer

) \(((ﬂ \

« Java JDK is available at; ‘==
http://www.oracle.com/technetwork/java/javase/downloads/index.html

* Eclipse IDE for Java EE Developers is available at:

http://www.eclipse.org/downloads/ a

The next instructions are given to:
(a) User wanting to add a newer SDK to their existing collection,

(b) First time users (who may or not be Eclipse users).



Setting up Eclipse + ADT + SDK

(a) Users Wanting to Update an Older Android Workbench

If you are currently using the Android SDK, you just need to update to the latest
tools or platform using the already installed Android SDK Manager.

1. Click on the [l SDK
Manager icon.

2. You will see a form similar
to the one on the right.

3. Select the SDK packages
and independent
components you want to
install (click ‘Install’
button and wait until they
are setup in your
machine...)

e | e

Packages Tools

SDK Path: C:\Users\1002125\AppData\Local\Android\android-sdk

Packages

' Name

a [ Tools
[] # Android SDK Tools
[7] 4 Android SDK Platform-tools
[7] .4 Android SDK Build-tools
[7] 4" Android SDK Build-tools

4 [ Android 4.3 (API18)

[7] [@ Documentation for Android SDK 18

[] 1§ SDK Platform
1 X Samples for SDK
[7] @8 ARM EABI v7a System Image
[V] 18 Intel x86 Atom System Image
[]1§ Google APIs
[1107 Sources for Android SDK
[T]C Android 4.2.2 (API17)
1C Android 4.1.2 (AP116)
[T]C2 Android 4.0.3 (API15)
[7]C Android 4.0 (API14)
[T Android 3.2 (API13)
[T]E Android 3.1 (API12)
[T]E2 Android 3.0 (API11)

Show: [V]Updates/New [V]Installed

Sort by: @ API level Repository

Done loading packages.

[7] Obsolete Select New or Updates

API Rev.  Status 2 "

2205 [ Installed
18.01 [ Installed
18.01 [ Installed

17 [ Installed

m

1 [ Installed
18 1 [ Installed
18 1 [ Installed
18 2 Lol
18 2 T Trroteie
18 1] [ Installed

m

Deselect All




Setting up Eclipse + ADT + SDK

(b) First Time Android Users who have Eclipse already installed

1. Obtain the appropriate (Windows, Max, Linux) Stand-alone SDK Tools for
Windows from the page http://developer.android.com/sdk/index.html

Execute the program, remember the folder’s name and location in which
the SDK is stored, you will have to supply this path to Eclipse.

2. Install the ADT Plugin for Eclipse (it must be already available in your machine)

1.
2.
3.

N o Un bk

Start Eclipse, then select Help > Install New Software....

Click Add button (top-right corner)

In the next dialog-box enter "ADT Plugin" for the Name and the following
URL for the Location: https://dl-ssl.google.com/android/eclipse/

Click OK

Select the checkbox next to Developer Tools and click Next > Next
Accept the license agreements, then click Finish.

After the installation end you need to restart Eclipse.

3. Add Android platforms and other components to your SDK (see previous
option (a) )

-11



Setting up Eclipse + ADT + SDK

Configure the ADT Plugin

4. The next step is to inform your Eclipse+ADT workbench of the android-sdk
directory’s location (this is the path you saved on Step1)

1. In Eclipse, select Window > Preferences... to open the Preferences
panel (Mac OS X: Eclipse > Preferences).

2. Select Android from the left panel.

3. To set the box SDK Location that appears in the main panel,
click Browse... and locate your downloaded SDK directory ( usually
C:\Program Files (x86)\Android\android-sdk )

4. Click Apply, then OK.

Done!

-12



Setting up Eclipse + ADT + SDK

Working with Virtual Devices (AVDs)

Ideally you should test your applications on a device (a physical phone or
tablet). However, the SDK allows you to create realistic virtual devices on
which your applications could be executed/debugged before they are
deployed on actual hardware.

3 Android Virtual Device (AVD) Manager ‘ =10| x|
Android Virtual Devices | Device Defnitions |

List of existing Android Virtual Devices located at C:\Users\1002125\.android\avd

AVD Name | Target Name | Platform | APIL... | cPu/ABI Create...

| | API10Gingerbread233  Android 2.3.3 v A R 10 Intel Atom (x86) Start...

| | API15-Icecream403 Android 4.0.3 4.0.3 15 Intel Atom (x86)

Edtl -
| | API16-JellyBean-412 Android 4.1.2 4.1.2 16 Intel Atom (x86)
Repair, .,
| | Api19-Kitkat-442-ARM  Android 4.4.2 4.4.2 ARM (armeabi-v7a) Delete
e Google APIs (x86 System

Wl ~r1i5tkataa2-Intel 0 o) (Google Inc ) Intel Atom (x86) Details. ..
Kl | —I | Refresh |
/\ A repairable Android Virtual Device. ¢ An Android Virtual Device that failed to load. Click 'Details' to see the error.

2-13




Creating a Virtual Device (AVD)

An AVD allows you to simulated devices and prototype
your solution on a variety of SDKs. To create a virtual

Setting up Eclipse + ADT + SDK

unit follow the next steps:

1.

B

© N oW

0

Click on the AVD Manager > Create. The Create New
AVD wizard appears requesting your input.

Type the name of the emulator, enter a value such
as “API119-Kitkat-442-Intel” (see figure on the right)
Select from the drop-downlist a Device (Nexus 4...)
and CPU/ABI such as Intel Atom (x86)

Choose a target from the already installed SDKs

(eg. “Android 4.4.2 - API Level19”).

Tick the Keyboard box to enable your PC’s keyboard.
Choose a skin of your preference (...dynamic hard ...)
Set memory RAM to no more than 768 MB

Indicate how much internal storage the simulator

will use (200MB).
Add a small SD card ( 9MB)
Click OK to create the AVD.

|} Edit Android Virtual Device (AVD) |

AVD Name:
Device:
Target:
CPU/ABI:
Keyboard:
Skin:

Front Camera:

Back Camera:

Memory Options:

Internal Storage:

SD Card:

Emulation Options:

| API19-Kitkat-442-Intel

[Nexus 4 (4.7, 768 x 1280: xhdpi) ~|
[Android 4.4.2 - API Level 19 |
[Intel Atom (x86) ~|
[V Hardware keyboard present

[Skin with dynamic hardware controls ¥ |
[None =
{None M|

RAM: |768 VM Heap: |64

| 200 (Mg ~|
> size: [9 (Mg ~|
" File: | Browse, ..,

[~ Snapshot [ Use Host GPU

I Override the existing &YD with the same name

o ]| ca

-14



Setting up Eclipse + ADT + SDK

AVDs are saved in the folder:
c:\Users\yourName\.android\avd\API19-Kitkat-442-Intel.avd

&L
O‘ Google \ (_J [cache img lock]
YOO | [hardware-gemu.ini lock]
| Lister - [c:\Users\1002125\.android\avd\APT| ] C5 =S EL VAL S|
Edit Optons Encoding Help [ [userdata-gemu.img lock]
aud.1n1.encodlng 1S0-8859-1 %, cache img
abi.type=x86 & config.ini
disk.dataPartition.size=2006H 4 emulator-user.ini
hw.accelerometer=yes % hardware-gemu.ini
hw.audiolnput=yes sdcard img
hw.battery=yes userdata.img
hw.camera.back=none i .
hw.camera.front=none ¢ a-qemu.img
hw.cpu.arch=x86
hw.dPad=no

hw.device.hash2=MD5:6930e145748b87e87d3f408cabd1408a41
hw.device.manufacturer=Google
hu.device.name=Nexus 4
hw.gps=yes
hw.keyboard=yes
hw.lcd.density=320
hw.mainKeys=no
hw.ramSize=768

hw.sdCard=yes
* hw.sensors.orientation=yes

hw.sensors.proximity=yes
hw.trackBall=no
image.sysdir .1=system-images\android-19\default\x86\
sdcard.size=9M
skin.dynamic=yes
skin.name=768x1280
skin.path=768x1280 .

tag.id=default saved in the /config.ini file
um.heapSize=64

Settings

Al




Setting up Eclipse + ADT + SDK

Creating a Virtual Device (AVD)

# ° 5554:Honeycomb3x

Some examples:

B 5554:dceCreamdx

Android

Friday, March 9

€ Charging (50%) Tablet showing Honeycomb 3.x

aaaaa

On top, a phone emulator
running lceCream 4.x
wearing a HVGA skin

Gingerbread 2.3 running on a custom skin

for Nexus-S. See page:
http://heikobehrens.net/2011/03/15/android-skins/




Setting up Eclipse + ADT + SDK

%) 5556:API16-JellyBean-412

Testing a Virtual Device (AVD)
Q, Google

1. Invoke the AVD Manager. Q
2. Choose an emulator, click Start.

See all your apps.
Touch the Launcher icon

'I Android Virtual Device (AVD) Manager

Android Virtual Devices | Device Definitions |

i

List of existing Android Virtual Devices located at C:\UsersX1002125\.android\avd
AVD Name | Target Name | Platform | APIL... | cPu/aBI

| | API110Gingerbread233  AndroidZ.3. 2.3.3 10 Intel Atom (X35

| API15-Icecream403 Android 4.0.3 Intel Atom (x86)
Qs sboensiz) o112 -
Repair
| Api19-Kitkat-442-ARM  Android 4.4.2 ARM (armeabi-v7a) -
Google APIs (x86 System
[ 7] aP119itkat442-Intel Image) (Google Inc.) 442 19 Intel Atom (x86)

. | ol

/A Arepairable Android Virtual Device. ¢ An Android Virtual Device that failed to load. Click ‘Details' to see the error.




Setting up Eclipse + ADT + SDK

(%) 5554:AP119-Nexus7-Tablet'44

Running a Virtual Device (AVD) Q G

1. Invoke the AVD Manager.
2. Choose an emulator, click Start.

3 Android Virtual Device (AVD) Manager

Android Virtual Devices | Device Definitions |

List of existing Android Virtual Devices located at C:\Users\1002125\.arfdroid\avd

AVD Name | Target Name [Patform [ APrLevel | cPujasr

D API10Gingerbread233 Android 2.3.3 2.3.3 10 Intel Atom (x86)
r_] API15-Icecream403 Android 4.0/ 4.0.3 15 Intel Atom (x86)
D AP116-JellyBean-412 Andfoid 4.1.2 4.1.2 16 Intel Atom (x86)
D API19-Kitkat-442-Intel Android 4.4.2 4.4.2 19 Intel Atom (x86)
E] API 19+Iexus7-Tablet;‘f42 Android 4.4.2 4.4.2 19 Intel Atom (x86)

Api19-Kitkat-442-ARM Android 4.4.2 4.4.2 19 ARM (armeabi-v7a)
C:D API20-SquareWare-44W Android 4.4W 4.4W 20 Android Wear Intel Atom (x86)

/% Arepairable Android Virtual Device. ¢ An Android Virtual Device that failed to load. Click 'Details' to see the error.




Setting up Android Studio

Working with Virtual Devices (AVDs)
L=

Your Virtual Devices

Android Studio

Type | Name l Resolution | API | Target | cpujasl | Size on Disk Actions ¥ |
[ aeniskitkatas 768 x 1280: xhdpi 19 Google APIs (x86 System Image) ~ x86 530 MB b 2~
[O] ceneric_SnWVGA APL.. 480 x 800: mdpi 2 Google APIs x86_64 1GB b 2 v
(O]  nNexus4apr22 768 x 1280: xhdpi 2 Google APIs x86_64  1GB b 2~
(O] nNexussapr22 1080 x 1920: xxhdpi 2 Google APIs x86_64 1GB b 2~
|+ Create virtual Device... | @

The Android Studio process to create, edit, remove, and execute AVDs is similar to the
strategy already discussed for Eclipse-ADT (only cosmetic differences on the GUI)



Example of an AVD Emulator wearing a HVGA Skin

ID —— Status Bar — Notification Line

< %) 5554:AP110Gingerbread233 b =101 x|
number

5554 :

nmn/

See all your apps. : - m | ‘A b a

Touch the Launcher icon. - \vﬁ‘

- -~ AR ()
Messaging  Camera Gallery Voicile FFFPFPF;F[J—

sy —— | EanEanonnEm
- o]l ]




AVD - Emulator wearing: Skin with dynamic hardw. controls

Numeric ID:
5554

& 5554:17-IceCream

APl Demos Browser

2 O

Camera Clock

$ O

Dev Tools Downloads

2

Gestures Google
Builder Settings

Messaging Music

Calculator Calendar

f =

Custom Dev Settings
Locale

B ~

Email Gallery

Navigation People




Controlling the AVD Operations

Keyboard OS function

Escape Back button
Home Home button
F2, PageUp Menu (Soft-Left) button

Shift-F2, PageDown

Start (Soft-Right) button

F3

Call/Dial button

F4 Hangup / EndCall button
F5 Search button
F7 Power button

Ctrl-F3, Ctrl-KEYPAD_5

Camera button

Ctrl-F5, KEYPAD_PLUS

Volume up button

Ctrl-F6, KEYPAD_MINUS

Volume down button

KEYPAD_5

DPad center

KEYPAD_4 DPad left

KEYPAD_6 DPad right

KEYPAD_8 DPad up

KEYPAD_2 DPad down

F8 toggle cell network on/off
F9 toggle code profiling
Alt-ENTER toggle FullScreen mode
Ctrl-T toggle trackball mode

Ctrl-F11, KEYPAD_7

switch to previous layout

Ctrl-F12, KEYPAD_9

switch to next layout

Controlling an Android
Emulator through your
computer’s keyboard

Note: Keypad keys only work when

NumlLock is deactivated.

1 5554:Gingerbread23

S owl @ 121

.

P T@ E TS % A R TR T
[P 7 P [ e g e e e

ALT




AVD - Emulator : Disk Images

Working with Emulator Disk Images

* The Android simulator uses QEMU technology [ Website: www.gemu.org ]

* QEMU is an open source machine emulator which allows the operating system and
programs made for one machine (e.g. an ARM CPU) run efficiently on a different

machine (e.g. your Windows PC).

When you create a Virtual Device, the SDK

C:\Users\yourFolder\.android\avd\API16-JellyBean-412

Makes several disk images containing among
others:

(1) OS kernel,

(2) the Android system,

(3) user data (userdata-gemu.img)

(4) simulated SD card (sdcard.img).

By default, the Emulator searches for the
disk images in the private storage area of the

AVD in use, for instance the “AP116-JellyBean-412” AVD is at:

C:\Users\yourFolder\.android\avd\API16-JellyBean-412

Mac OS users should look into ~/.android/avd

cache.img.lock
hardware-gemu.ini.lock
, sdcard.img.lock

userdata-qemu.img.lock

@ cache

= | config

=

=% emulator-user

| hardware-gemu

E sdcard

-23




Transferring Files to/from Emulator’s SD Card
Upload/download Data, Music and

. . 4
Picture files to the Emulator’s SDcard = (BT ‘ %5 Debug
S

1. Eclipse developers needs to add the

DDMS perspective. : ® - | Open F'EEpE::i‘i*.-‘EI e
/ "I" s 1L !9. - S S

2. Android-Studio uses the equivalent

‘ . . . , @ DDMS - 01-Hello-World/src/csu/matos/HelloWorldActivity.java - Eclipse o8
And rOId DeV|ce Monltor bUtton- File Edit Source Refactor Navigate Search Project Run Window Help
3. Change to the DDMS perspective. Ll L L =
4 b ¥ == '~

Make sure your AVD has started (You :
will see a layout similar to the figure on || ® tndorConiol] @ Deices
the lower right side)

2, Threads 7} Heap @ Allocation | = O

Size Date
4. Click on the File Explorer tab. B e
5. Expand the mnt (mounted devices) e a # o0
folder. smete e
6. Expand the sdcard folder R = e 2°1l'°2'°3'
7. Open your Window'’s Explorer. D LogCat| @ Corsole % =5
8. Choose a file stored in your PC. . HEEEMELS

Transfer a copy to the emulator by
dragging and dropping it on top of the EE—
sdcard folder. ‘ Launching 01-Hello-World




Transferring Files to/from Emulator’s SD Card

Upload/download Data, Music and
Picture files to the Emulator’s SDcard

18] DDMS - 01-Hello-World/src/csu/matos/HelloWorldActivityjava - Eclipse

File Edit Source Refactor Navigate Search Project Run Window Help

@

B & Java

0
s

an Q% A %
B S5 d

= | &
@uv| I, <« Public Pictu... » Sample Pictures v I s l l Search Sample Pictures O ‘
File Edit View Tools Help
Organize v Share with v Slide show Bumn  » = ~ @ @
7 Favorites Pictures library R it Pkl

Ml Desktop
& Downloads
= Recent Places

Sample Pictures

E

4

B

-:' Sign in to Google...

Launching 01-Hello-World

- 0 - . code
»-0-Q- - =N R A
v v \r\:' v v - Libraries Chrysanthemum Desert
i = - - ; i %] Documents .
@ Emulator Control | [g Devices i3 = B4 File Explor %, Threads| @ Heap| § Al| ¢ :'“‘i‘ Byt N
| &= Pictures ~p
QA M 3 D s E 5
| W | h 2 | 3 | @ H - :/betlc:tfres Hydrangeas Jellyfish =
. Public Pictures Kt |
M (VEY-EP “ |1 Name B Videos ‘; * &
B emulator-5554 Online =< » (= data : A
- 1™ Computer
system_process 61 A @ &, Local Disk () R Lighthouse
com.android.inputmethod 121 , gYeC e
com.android.phone 126 > (> obb @ Network M
com.android.systemui 130 é/ I .
: i Penqui Tuli -
com.android.launcher 133 > (= secure e e e
com.android.settings 164 » (& system ’
android.process.acore 178 o e
<« | m » < m J
& LogCat | Bl Console &2 =0
Android W BBl B v’ G WLST +

2-25




Transferring Files to/from Emulator’s SD Card

Upload/download Data, Music and Picture files to the Emulator’s
SDcard

8. Return to the emulator. This time you may use native apps such as ‘Music’ and
‘Gallery’ to see your recently uploaded multimedia files. For instance...

Ml @ 10:35em

Dl ® 11:14em DH @ 11:11em
’

40th Anniversary

Ray Conniff

Cinema Paradiso (Theme)
Henry Mancini

The Adventures of Sherlock

Sir Arthur Conan Doyle

The Good, the Bad and the Ugly 2::

Starbucks Entertaiment - Bella Luna

Bella Luna

Starbucks Entertaiment - Bella Luna

Il cuore e' uno zingaro

Nicola Di Bari

[} Henry Mancini

Cinema Italiano: Music of E

X Henry Mancini

Io e te Maria

Nicola Di Bari

O Cinema Italiano: Music of Ennio Morricon...

Py Amarcord

Lo Mejor

Los Melodicos

Mack The Knife
Starhiicke Entertaiment - B

Los Melodicos tocan jazz

Los Melodicos

Amarcord
Henry Mancini




Transferring Files to/from Emulator’s SD Card

Upload/download Data, Music and Picture files to the Emulator’s
SDcard

9. Pictures may be displayed by clicking the Application Pad and invoking the
Gallery application

D@ 11:21em
E 3 -

Alarm Clock APP1 Browser Calculator

5 m

Camera Car Home Contacts Custom
Locale

Dl ® 11:24em

All-p’iiztures

# &N W

DevTools Email Gallery Maps

A

(1)
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Setting up Eclipse + ADT + SDK
Locate your ‘android-sdk’ & AVD folder

After you complete your setup look for the following two subdirectories in

your PC’s file system @\
C:\Program Files (x86)\Android\android-sdk ‘ '(l\(\w

5 4
\ ./
& R

, add-ons A .‘
. build-tools : I C:\Users\yourWindowsUserName\.android\avd
S u . API110Gingerbread233.avd
. platforms
, API15-Icecream403.avd
. platform-tools
. AP116-JellyBean-412.avd
. samples
. Api19-Kitkat-442-ARM.avd
, sources
) . API119Kitkat442-Intel.avd
, system-images
temp £ API10Gingerbread233
' tools £ API15-Icecream403
[EZJAVD Manager £ API16-JellyBean-412
[ 7ISDK Manager £ Api19-Kitkat-442-ARM
SDK Readme £ API19-Kitkat442-Intel
& uninstall
This folder contains your Android This directory holds your

SDK, tools, and platforms Virtual Devices (AVDs)



Android Studio: Hello World App

Example 2.1 : HelloWorld App

| android studio | =l5(x
We will use Android Studio

IDE to create a bare bone app. | 9 Welcome to Android Studio

Click on the entry: ‘Start new
Android Studio Project’ .

A wizard will guide you
providing a sequence of menu &
driven selections.

Recent Projects Quick Start

!’.ETTJ

Start a new Android Studio project H

Open an existing Android Studio project

|
R Import an Android cocle sample

The final prOdUCt iS the Vis Check out project from Version Control
skeleton of your Android app.

]
E‘" Import project (Edipse: ADT, Gradle, etc.)

j;:‘, Configure 2
I-E. Docs and How-Tos L

Android Studio 1.3.2 Build 141.1!178183. Check for updates now.

Android apps are usually made of a rich collection of various type of components including Java
code, multimedia resources, XML files, etc. The New Android Studio Project Wizard facilitates the
assembly of those parts and organizes the components in various sub-directories.



Android Studio: Hello World App
Example 2.1 : HelloWorld App

x|
1. Enterin the Application Name box: New Project
HeIIoApp Android Studio
2. Enter Company Domain: csu.matos Configure your new project
(usually a dot-separated string
consisting of company and N
programmer’s name) Lo 1
Company Domain: ltsumatos ‘
Package name: matos.csu.helloappj Edit

3. Click Next

Project location: C:\Users\1002125\AndroidStudioProjects\HelloApp ‘ B




Android Studio: Hello World App

Example 2.1 : HelloWorld App

4. Select Target Android Device. In this
example Phone and Table is already
checked. Other options are: Wear,
TV, Auto, Glasses.

5. Choose from drop-down list the
Minimum SDK on which the app will
work. In this example we have
selected: API22 Android 5.1
(Lollipod)

6. Click Next

¢ Create New Project 5]

H Target Android Devices

Select the form factors your app will run on

Different platforms may require separate SDKs

[ 2 Phone and Tablet

Minimum SDK | API 22: Android 5. 1 (Lolipop)

LOWEr AF1 IeVels (alrQe 10re gdevices: y DU
available. By targeting API 22
and later, your app will run on < 1% of the devices that are

active on the
Google Play Store.
Help me choose
[C] wear
Minimum SDK [API 21: Android 5.0 (Lollipop) n
Jv
Minimum SDK [Apx 21: Android 5.0 (Lollipop) n
] Android Auto
[ Glass (Not Installed)
Minimum SDK n
o | e | | ]
2
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Android Studio: Hello World App

Example 2.1 : HelloWorld App

7. Select the pre-defined app template
to apply. In this example we choose:
Blank Activity

8. Click Next

fcreatenewproe

Add an activity to Mobile

Add No Activity
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Android Studio: Hello World App
Example 2.1 : HelloWorld App

9. The wizard is ready to construct the
solution. The text-boxes give you an
opportunity to change any of the
default names given to the main
activity, the app’s layout, its title, e o

and menu. Please do not change S
Nk
anything now. B

~

Activity Name: MainActivity

A e @ Layout Name:
10. Click Finish -

Menu Resource Name: m

>

11. You are done! (your next step is to
try the app on the emulator —
explained later in this lesson)

Blank Activity

The name of the activity dass to create

[erevios | x| [[concet || (DN




Android Studio: Hello World App

Example 2.1 : HelloWorld App

The app’s GUI and the Palette (graphical toolbox) are shown. On the left pane, the
Project Explorer shows the application’s file structure.

§ HelloApp - [C:\Users\1002125\AndroidStudioProjects\HelloApp] - [app] - ..\app\src\main\res\layout\activity_mai droid Studio 1.3.2 _]nlzl
File Edit View Navigate Code Analyze Refactor Build Run Tools VCS Window Help
DHD ¢#2 XH0 QR ¢ > (R~ 2 b 3 TR & ? Q
[ HelloApp - ["7app ~ [7sc [“Imain » [res [1layout » & activity_main.xml
g | Wt Android v | € % | #- |- | (© Manactivity.java x | [ activity_main.xml x | -
5 -
Z% v Fg’m&sg Palette #-1- [L- [Nexus4~ [jv (DApptheme  ComponentTree = =S = g
®| » [java S Eayoars MainActivity+ @~ 1122~ v i Device Screen %
FrameLayout A v [HiRelativeLayout c
v [ares ] ) ) 3 ) | @® @ 2
[+ drawable [[[]uineartayout (Horizontal) bd @B o # [Ab) Textview - @string/hello_world 71
v [layout [] LinearLayout (vertical)
= O
= 3 activity_main.xml DTableLayout (E;
” > B = Tablerow g
> [ mipmap [1] GridLayout @
o F .
5 > BIv [H]RelativeLayout
2 () (@ Grade Scripts 03 Widgets
"’.\TI [Ab] Plain Textview
v [AbLarge Text
[Ab) Medium Text
[Ab] Small Text Properties ?2 5Y
0K Button
ok Small Button
(®) RadioButton layout:height wrap_content
[+] checkBox » layout:margin 1]
i layout:alignEnd
« ToggleButton y lign
3 B ImageButton layout:alignParenténd [
-
3 Bl mageview layout:alignParentStari [_|
|§ == ProgressBar (Large) = w——
;" == ProgressBar (Normal) i
== ProgressBar (Small) layout:toEndOf
@ == ProgressBar (Horizontal) layout:toStartOf
; = la t:alignC t
5 % RatingBar » layout:alignComponent []
2 —~ Spinner » layout:alignParent ]
o -~y P g
w ] Design | Text |
Terminal ~ § 6: Android /& 0: Messages % TODO 0 EventLog [£] Gradle Console
;I Gradle build finished in 5s 937ms (3 minutes ago) n/a n/a |Context: <no context w8




Android Studio: Hello World App
Example 2.1 : HelloWorld App

* Java/ Holds your Main-Activity Java code. All

= app
other Java files for your application go here. ] manifests
[ 1ava
* res/ This folder stores application resources such (21 matos csu helloapp

as drawable files, Ul layout files, string values, i i Machithaty

menus, multimedia, etc.

* manifests The Android Manifest for your project. i {,-HE i

7] matoe ceu helloapp (2ndroid|

7 lavout

-:: activity _main., xmil
57 menu

@ menu_main, xml
[i] mioman
i velues

%7 dineres, xedl [2)

tr gtringz. xm

[57 styles.eml {2
** Gradle Scrpts



Android Studio: Hello World App
Example 2.1 : HelloWorld App —Java Code: MainActivity.java

package matos.csu.helloapp;
import ..

public class MainActivity extends Activity {

@Override

protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity main);

}

@Override

public boolean onCreateOptionsMenu(Menu menu) {
// Inflate the menu; this adds items to the action bar if it is present.
getMenuInflater().inflate(R.menu.menu_main, menu);
return true;

}

@Override

public boolean onOptionsItemSelected(MenuItem item) {
// Handle action bar item clicks here. The action bar will
// automatically handle clicks on the Home/Up button, so long
// as you specify a parent activity in AndroidManifest.xml.
int id = item.getItemId();

//noinspection SimplifiableIfStatement
if (id == R.id.action_settings) {
return true;

}

return super.onOptionsItemSelected(item);



Android Studio: Hello World App

Example 2.1 : HelloWorld App - Layout: activity_main.xml

C MainActivity.java x 5 activity_main.xml x Preview

© <RelativelLayout xmlns:android="http://schemas.andr® [L- Finews4- [T~ DappTheme " ManActvity~ @~ i§i22~

</RelativelLayout>

xmlns:tools="http://schemas.android.com/tools"
android:layout_width="match_parent”
android:layout_height="match_parent”
android:paddingLeft="16dp"
android:paddingRight="16dp"
android:paddingTop="16dp"
android:paddingBottom="16dp"
tools:context=".MainActivity">

QA D

HelloApp

<TextView
android:text="Hello world!"
android:layout_width="wrap_content”
android:layout_height="wrap_content™ />

Design

Text




Eclipse: Using the ‘New Android Application’ Wizard

Example2.1 (again..) : HelloWorld App

We will use Eclipse + ADT to create a
bare bone app. All it is needed from
the developer is to feed the New
Android Application wizard with a few
selections (no extra code will be added
to the default app skeleton generated
by the IDE+SDK).

The adjacent figures show the solution
made by the wizard running on a Jelly
Bean emulator and device.

(&) 5556:AP116-JellyBean-412

‘fi HelloWorldApp

Hello world!

767 o 5 QT %, 0 9:54 pm

HelloWorldApp

Hello world!




Eclipse: Using the ‘New Android Application’ Wizard

Example : HelloWorld App

1. Start Eclipse

2. From menu choose File > New >
Android Application Project

3. Enterin the Application Name box:
HelloWorldApp

4. Enter Project name:
HelloWorldAppProject

5. Modify Package Name prefix to:
csu.matos.helloworldappproject

6. For Minimum Required SDK choose:
API 10: Android 2.3.3 (Gingerbread)

7. For Target SDK select the option:
APl 16:Android 4.1 (Jelly Bean)

8. Select for Compile With the option:
APl 16:Android 4.1 (Jelly Bean)

9. Click Next

10. Click Next

New Android Application
Creates a new Android Application

ipi

o~

Application Name: OI HelloworldApp

Project Name: © | HelloWorldAppProject

Package Name: OI csu.matos. helloworldappproject

Minimum Required SDK: & API 10: Android 2.3.3 (Gingerbread)

=

Target SDK: @[ API 16: Android 4.1 (Jelly Bean) |
] 271 16: Android 4.1 QelyBean) [ Rd|
Theme: & [Holo Light with Dark Action Bar =l

9

Choose a target API to compile your code against, from your installed SDKs. This is typic
the first version that supports all the APIs you want to directly access without reflection.

Next >

Finish Cancel




Eclipse: Using the ‘New Android Application’ Wizard

Example : HelloWorld App

On the form Configure Launcher Icon
do the following:

11. Foreground > Clipart > Choose
12. Select an icon from the set of

{:) New Android Application

Configure Launcher Icon

Configure the attributes of the icon set

10| x|

O

Foreground: | Image | Clipart | Text |

=¢

Preview:

@
PN
hdpi:
available images > Close T Q
. Additional Padding:
13. Pick a Foreground Color T P
14. Click Next R - khdpi:
shapeINonelswafeICrdeI e
srandco Al
Foreground Color: [ERc
rOCXomO OB L —
== 2?20 A A= 42+
all 2 & C I omow o ) X[
SEOAOO Y @K LE»
- O <Back Next > Firish Cancel
(o= 1)




Eclipse: Using the ‘New Android Application’ Wizard
Example : HelloWorld App

{}New Android Application | =10 x|
The Create Activity form provides a | creteAdivity @
. Select whether to create an activity, and if so, what kind of activity.
number of basic templates from
which your application could be [V Create Activity
[ Blank Activity L]
constructed. m e
Empty AcﬁvitY 4 (.
Fullscreen Activity
« o Master /Detail Fl
15. Select the Blank Activity Nevigation Drawer Acthity
Tabbed Activity
template.
16. Click Next.
Blank Activity

Creates a new blank activity with an action bar.

©) <Back Next > Finish Cancel
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Eclipse: Using the ‘New Android Application’ Wizard

Example : HelloWorld App

The Blank Activity form provides a way
to name the main Activity and Layout
name.

17. Leave the default values shown in
the form (Activity Name and Layout
Name).

18. Click Finish.

At this point the wizard has completed
all the steps required to make the app.

After a few seconds the Eclipse
perspective shows the app’s Ul. The Java
solution is shown in the PackageExplorer
pane (see next pages)

0 ew Androd Application
Blank Activity

Creates a new blank activity with an action bar.

—lolx|

P

Activity Name © | MainActivity

Layout Name © | activity_main

., The name of the activity dass to create

@ [_Fesn |

< Back ext >




Eclipse: Using the ‘New Android
Application’ Wizard

Example : HelloWorld App

File Structure
The folders and files shown on the
figure are part of the newly created

app.

Here we are using Eclipse’s Package
Explorer facility to navigate inside
the folder holding the app.

To test the application, position the
cursor on the code panel, and then
click on the Run menu button. O

7

[% Package Explorer $3 =

H-2 HelloWorldAppProject

S

&--E-E-E-

0--&=--F-
s PPPPEELE

F_'C‘K'F_'F_‘K'ae?gf
VB 3

& src

=} csu.matos.helloworldappproject
[+ D MamActJvuty java <—
gen [Generated Java Files]

Android 4.1.2 %

Android Private Libraries

Android Dependendes

assets

» drawable-hdpi
» drawable-dpi
» drawable-mdpi
» drawable-xhdpi
» drawable-xxhdpi
» layout
< activity_main.xml <——
> menu
> values
> values-v11
. values-v14
. values-w820dp
AndroidManifest.xml <——
ic_launcher-web.png

0--&--E--&-

®=--&-E-&-E-
VAVAVAVAN

| S—

; B proguard-project. txt

project.properties




Eclipse: Using the ‘New Android Application’ Wizard
File Structure of a Typical Android App

* src/ Includes your skeleton Activity Java file. All other Java files for your
application go here.

* <Android Version>/ (e.g., Android 4.1/) Includes the android.jar file that
your application will build against.

» gen/ This contains the Java files generated by ADT, such as your R.java file

* assets/ This is empty. You can use it to store raw asset files.

* res/ This folder holds application resources such as drawable files, Ul
layout files, string values, etc.

* bin/ The bytecode (.apk) version of your app is stored here

* AndroidManifest.xml The Android Manifest for your project.

* default.properties This file contains project settings, such as the build
target.



Android Emulator — Looking Under the Hood /@?
/‘,
f

\45\
Login into the Android OS shell @

r N
.. C:\windows\system32\cmd.exe - adb shell lﬂ@
AlthOUgh It IS not Microsoft Windows [Version 6/.1.7608]
Copyright {(c) 2889 Microsoft| Corporation. All rights reserved.
necessary, a dEVEIOPQr :\Progran Files (x86>\Androfid\android-sdk\platforn-tools>adb shell
may galn access tO root root 2012-A3-10 H config
PUX I system cache 2012-03-10 H cache
1 Iruxruxrux root root 2012-83-10 H sdcard —> /mnt/sdcard
Some Of the |nnerm05t druxr—xr—x root root 2012-83-10 H acct
druxruxr—x root systenm 2012-03-10 06: mnt
1 Iruxruxrux root root 2012-03-10 066: vendor —> /system/vendor
pa rtS Of the And rOId Iruxruxrux root root 2012-03-10 066: d —-> /sys/kernel/debuyg
Iruxruxrux root root 2012-03-10 066: etc —> /systemfetc
C)E; —rw—r——r—— root root 1969-12-31 19: ueventd.rc
. root root 1969-12-31 19: ueventd.goldfigsh.rc
root 2011-82-83 18:
root 1969-18-31 ' 19=
root 1969-12-31 19:
X1 3 root 1969-12-31 19: 3
H X o root 1969-12-31 19: init.rc
For a UNIX-like e . . 1969-12-31 19:88 init.goldfish.ic
! 3 g 1969-12-31 19:

1969-12-31 19: default.prop

experience you can log e : 30128309 73:03 data
into the system by ‘

2018-81-27 19: root
2012-83-10 00: dev

executing the emulator | i 3 e
and issuing selected ek dave
shell commands. ‘ soan

855M

2012-03-09 - LOST.DIR
2012-83-10 - DCIM
5239976 2012-03-09 = Amarcord.mp3
2012-03-09 H Android
3 263230 2012-83-09 H Bea-Strada-Uolterra—-12X17. jpg
——==PUXP—X vk 314676 2012-83-89 : Bea-Uic—-Arno—FKFirenze.j




Android Emulator — Looking Under the Hood

\3\46\
[ ° . J/ ,/%
Login into the Android OS shell /&%’/f

r N
C:\windows\system32\cmd.exe - adb shell lﬂ@
STEPS Copyright {(c)> 2069 Hicx*osoft.C(;Pporation. All rights reserved.
1. Use the Eclipse AVD
S root root 2012-03-10 H config
Manager to Sta rt One druxrux——— system cache 2012-03-10 H cache
Iruxruxrux root root 2012-83-10 H sdcard —> /mnt/sdcard
PUXE X root root 2012-83-10 H acct
Of your AVDS ( Say PUXBUXE root system 2012-083-10 00: mnt
. S root root 2012-03-10 066: vendor —> /system/vendor
Iruxruxrux root root 2012-03-10 066: d —-> /sys/kernel/debuyg
Glngerbreadzg) Iruxruxrux root root 2012-03-10 066: etc —> /systemfetc
—rw—r——r—— root root 1969-12-31 19: ueventd.rc
—ru—pr——pr—— root root 1969-12-31 19: ueventd.goldfigsh.rc
druxr—xr—x root root 2011-02-03 18: system
\ root root 196 =12 =S 1919 = sys
v root root 1969-12-31 19: shin
2- At the DOS Command =X P XE root root 1969-12-31 19: proc
gt root root 1969-12-31 19: init.rc
v root root Y GY=T o= I s init.goldfish.ic
prompt level run the & 19691231 19:00 init
S0 S root root 1969-12-31 19: default.prop
H H MIXE system system 2012-03-09 23: data
Android DEbUg Brldge dr root root 2010-81-27 19:59 root
. . gx‘gifr—xr—x root root 2012-83-10 00: dev
(adb) application it
Filesystem Size Free Blksize
/dev 125M 125M 4096
/mnt/asec 125M 125M 4096
125M 125M 4096
96M %) 4 4096
adb shell 64M 31M 4896
64M 62M
1019M 855M
855M
2012-83-89 - LOST.DIR
2012-83-10 - DCIM
5239976 2012-03-09 = Amarcord.mp3
2012-83-89 H Android
263230 2012-83-09 H Bea-Strada-Uolterra—-12X17. jpg
314676 2012-83-89 : Bea-Uic—-Arno—FKFirenze.j
£ m »
|

adb is a tool located in the directory:
C:\Your-SDK-Folder\Android\android-sdk\platform-tools\ 2-46




Android Emulator — Looking Under the Hood
Login into the Android OS shell

If more than one emulator is running (or your phone is physically connected to the
computer using the USB cable) you need to identify the target.

Follow the next steps:

1. Get alist of attached devices

dows\system?

. Microsoft Windows [Version 6.1.7601]
adb de\[lces Copyright (c) 2009 Microsoft Corporation. All rights reserved.

C:\Program Files (x86)\Android\android-sdk\platform-tools>adb devices

List of devices attached

List O-F deViceS attached emulatop-sssd de\/ice
. emulator-5556 device
emulator-5554 device HT249W301880  device
emulator-5556 device
HT845GZ45737 dev:i.ce C:\Program Files (x86)\Android\android-sdk\platform-tools>

2. Run the adb application as follows:
adb -s emulator-5554 shell

Remember, the adb tool is located at C:\Program Files (x86)\Android\android-sdk\platform-tools\



Android Emulator — Looking Under the Hood
Login into the Android OS shell

Android accepts a number of Linux shell commands including the useful set below

1S i e e show directory (alphabetical order)
mkdir .............. make a directory

rmdir ... remove directory

b (s OO to delete folders with files

i 0 remove files

TV o e e e e oo o asoeenses moving and renaming files

(= displaying short files

07 change current directory

Pwd .. find out what directory you are 1in
df ... i i e, shows available disk space

chmod .............. changes permissions on a file

date .......... ..., display date

exit ...t terminate session

There is no copy (cp) command in Android, but you could use cat instead.
For instance:

# cat data/app/theInstalledApp.apk > cache/theInstalledApp.apk



Hacking: Moving an app from a Rooted Phone to the Emulator

Android Emulator — Looking Under the Hood

If you want to transfer an app that is currently installed in your rooted developer’s
phone to the emulator, follow the next steps:

1.

Run command shell: > adb devices (find out your hardware’s id, say
HT096P800176)

Pull the file from the device to your computer’s file system. Enter the command
adb -s HT096P800176 pull data/app/thelnstalledApp.apk
c:\thelnstalledApp.apk

Disconnect your Android phone
Run an instance of the Emulator

Now install the app on the emulator using the command
adb -s emulator-5554 install c:\thelnstalledApp.apk
adb -s emulator-5554 uninstall data/app/thelnstalledApp.apk <«— to uninstall

You should see a message indicating the size of the installed package, and finally:
Success.
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Android Emulator — Looking Under the Hood

Simpler than Hacking: Install a File Manager for Android

Visit Google Play Store and choose a user-friendly file manager app from the various
(usually very good) options available.

A file manager app allows you to easily administer the folders and files in the system’s
flash memory and SD card of your Android device (or emulator).

Al |4 =
“\u o o P o5

File Manage ASTROFile ! File Manage Android File otal Commz ESFileE

A sample of File-Management apps seen at https://play.google.com on Aug-27t% -2014




Android Emulator — Looking Under the Hood

Using an alternate SD card & userData Image

r
{.] Run Configurations

]

Create,

and run confi

Android Application

& Apache Tomcat

[G4 Compile GWT Applice
@ Eclipse Application
E3 Eclipse Data Tools

& Generic Server

| Generic Server(Externz
[ GlassFish Application
[G] GWT Application =
[ GWT JUnit Test
Ju GWT JUnit Test
:| HTTP Preview
@' Iron Python Run
& Iron Python unittest
| J2EE Preview
[¥5] Java Applet
[3] Java Application
Ju JUnit
Ju JUnit Plug-in Test
@” Jython run
& Jython unittest
[¥] Mwe2 Launch
+3; Oracle Coherence
‘@ Oracle Public Cloud L
“a Oracle WebLogic Scrip ~
)

Filter matched 39 of 168 items

.

01-Hello-World

»®

Name!

© Automatic
Select a preferred Android Virtual Device for deployment:

AVD Name CPU/ABI

Target Name Platform  APILevel
[v] Gingerbread23 Google APIs (Google... 233 10 ARM (arme
Nexus-S Google APIs (Google... 233 10 ARM (arme
Honeycomb3x Google APIs (Google... 3.2 13 ARM (arme
< m »
Emulator launch parameters:
Network Speed:
Network Latency:
Wipe User Data
Disable Boot Animation
Aw.ons —

-sdcard c:\My_Emulator_Data\myreallybigsdcard.img -datadir c:\My_EmuIatoD

[ Apply ] [ Revert

)

From the Eclipse menu create a
new launch configuration: Q-
Run > R

Run Configurations >
New icon

On the Target panel:

1. Select existing AVD (Gingerbread
in this example)

2. Enter additional Command Line

Options (see caption below)

3. Click on Apply > Run

Additional Emulator Command Line Options:
-sdcard c:\My_Emulator_Data\myreallybigsdcard.img -datadir c:\My_Emulator_Data




Android Emulator — Simulate Texting

Sending Text Messages from your Window’s PC to the Emulator

1. Start the emulator.

2. Open anew DOS command shell and type :
c:> adb devices
this way you get to know the emulator’s numeric port id (usually 5554,
5556, and so on)

3. Initiate a Telnet session with the sender at localhost, port 5556 identifies
an active (receiving) Android emulator. Type the command:
c:> telnet localhost 5554

4. After receiving the telnet prompt, you can send a text message to the
emulator on port 5554 (no quotes needed for the message)
sms send <Sender’s phone number> <text message>

Windows7 — temporarily install Telnet Client by using a command line
1. Click Start button, type cmd in the ‘search programs and files’ box, and then press ENTER.

2. Type the following command: pkgmgr /iu:"TelnetClient”

-52



Android Emulator — Simulate Texting

Sending a text Message (SMS)
from your PC to the Emulator

‘ a Beatriz Aurenty: don't forget we have a
FRPPITRLT RN Foul ™ - T

LS 7 g

& [&5 |
- Rl @ 2:45am

Beatriz Aurenty <216-555-1122>

KN

I

EA Clwindows\system32icmd.exe

|

§ Beatriz Aurenty: don't
] forget we have a ballroom
— class tonight at 8:30pm
Sent: 2:44AM

@Y Telnet localhost

ndroid Console: type 'help’

for

a I1

Type to compose

mf

st of commands




Android Emulator — Simulate Phone Calls

Making a Phone Call from your PC to the Emulator

1.

Start the emulator.

Open a new shell and type :
adb devices
to know the emulator’s numeric port id (usually 5554, 5556, and so on)

Connect to the console using telnet command like:
telnet localhost 5554 (5554 is the ‘phone number’ to be called)

After receiving the telnet prompt you can place a call (voice) with the
command
gsm call <caller’s phone number>
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Android Emulator — Simulate Phone Calls

DMl 6 2:52am

Example:
Making a Phone from your PC to the
Emulator

Incoming call

Beatriz Aurenty

Home 555-1122

BN Chwindows\system32iomd.exe

o

ers\1002125>telnet localhost 5554

EA Telnet localhost

Android Console: type "help ftor a list of commands
OK

gsm call 5551122
OK
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Using: Android Device Monitor

It is much simpler to test telephony operations (SMS/Voice) as well as GPS
services using the controls included in the IDE (both AS and Eclipse)

1. Telephony Status - change the state of the phone's Voice and Data plans
(home, roaming, searching, etc.), and simulate different kinds of network
Speed and Latency (GPRS, EDGE, UTMS, etc.).

2. Telephony Actions - perform simulated phone calls and SMS messages to
the emulator.

3. Location Controls - send mock location data to the emulator so that you
can perform location-aware operations requiring GPS assistance.

* Manually send individual longitude/latitude coordinates to the
device. Click Manual, select the coordinate format, fill in the fields
and click Send.

 Use a GPX file describing a route for playback to the device.

 Use a KML file to place multiple placemarker points on a map



Using Eclipse’s DDMS facility

DDMS Telephony Services

®; DDMS - 01-Hello-World/src/csu/matos/HelloWorldActivity.java - Eclipse

Send text_messages File Edit Source Refactor

Navigate Search Project Run Window Help

Makeaphoneca” Cived B~ & O a6l Bid H-0-Q-
@BQ"v@ 32 o B gl o vt O v v
\ G Devices 32 . = &nulatm(:ontrol Sé s =8 b%;ﬁl File Bx 83 %, Threa | (@ Heap Alloca 8|
q < | | |
Telephony Status o RE| =+
Voice: [home v] Speed: [Full Name Size *
(= data
Data: |h Latency: | N
ata [ ome v] atency: [ one '] & mnt
Telephony Actions (= asec
(= obb
Incoming number: 5551122 @ °
o BT process ) (= sdcard -
Beatriz Matos : Msg sent from Edlipse’s com.android.inputmet| ) Voice ] Amarcord.mp3 5239976 |~
com.android.phone = (= Android
com.android.systemui Message: Msg sent from Eclipse's P |- Bailables.mp3 4948579
kxoogle Search | QJ com.android.launcher Emulator Control |=] Bea-Strada-Volterra-12X17.jpg 263230
[ com.android.settings |=] Bea-Vic-Arno-Firenze.jpg 314676
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Lesson 2:
Setup: Android Workbench & Emulator

stions ?



Appendix 1 - Using a Hardware Device

Connecting your Physical Device to the Computer

1.

vk wnN

Make sure the USB driver has been installed in your PC ( click T SDK Manager >
Extras > check box [Google USB driver package] to install )

Use a mini-USB cable to connect the device to your computer.

Expand the Notification bar. Click on [USB connected] option.

Click on [Turn on USB storage ] to mount the device.

Now you could now use the Eclipse-ADT-File Explorer and your Window’s Explorer
tool to pull/push/delete/rename files to the device.
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Appendix 2 — Emulator-to-Emulator Interaction

1. Run two instances of the emulator (typical IDs are: 5554, 5556, ...)
2. Dial (or send SMS) from one of them (say 5554) to the other (5556)
3. Press the Green/Red call buttons to accept/terminate the call
4. Try sending SMS (use numbers 5554 and 5556)
P e —
€ 5554:Gingerbread23 [
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Appendix 3 — Sync your Contacts

How to Transfer Your Google Contacts into the Emulator

¢ Favorites S .)

1. Go to your Gmail account using a web browser, click on Gmail > riemi-iboe - me

Contacts on the left sidebar. [ ]
Google
2. Select all the contacts you want on your emulator/phone. Then Gma"
click on More > Export and select vCard format. Download the S
“contacs.vcf” file to your PC. —

Important
Sent Mail

3. Push the contacs.vcf file from the PC to the emulator’s SD card.

4. Open the emulator’s Contacts app hit Menu > Import.

Contacts

5. Choose the option Import from SD card.

Source visited on July 2009, link:
http://stackoverflow.com/questions/1114052/importing-gmail-contacts-on-android-emulator




Appendix 4

Shortcuts: Android-Studio IDE

x|
Eclipse developers are @ ) Editor > General > Auto Import Reset

used to typing R -
eymap

Editor Show import popup

Ctrl + Shift + O senere e

Smart Keys

Appearance Insert imports on paste:| | All n

. . Editor Tabs :

To Organize ALL imports. Code Folding Shom mport BoPUP
Code Completion

optimize mports on e f
To automatically Postfix Completion Add unambiguous imports on the fiy
Console Folding

accomplish the same Colors & Fonts Exclude from Import and Completion

. Code Style
effect, modify your S

An d ro | d Stu d io File and Code Templates
. . File Encodings
Workbench as indicated T

. . File Types
on the figure to the right. copy,ﬁt 2

Emmet
Images

File > Settings > Editor > Intentions

Language Injections E
General > Auto Import o - Show import popup

TODO
Plugins
Version Control
Build, Execution, Deployment

o

3 @ @
I

C/C++
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Shortcuts: Android-Studio IDE

Operation

Reformat code

Optimize imports

Code Completion

Issue quick fix

Surround code block

Line Comment or Uncomment

Block Comment or Uncomment

Close Active Tab
Build and run

Build
All Options

Appendix 4

Android Studio Shortcut
CTRL+ALT +L
CTRL+ALT+0O

CTRL + SPACE

ALT + ENTER
CTRL+ALT+T

CTRL+/

CTRL + SHIFT +/

CTRL + F4

SHIFT + F10

CTRL + F9
Ctrl + Shift + A
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